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3. The MathType Toolbar (in Word)   

 
 
The MathType toolbar contains 10 icons, or 11 if you’re using Windows 7 or Mac with Word 2011. The 
descriptions below should help you decide when to use each of the icons. 
 
Note: If you are using Office 2007 or 2010, these items are included in the MathType tab on Word’s 
Ribbon. Some are also included on the Ribbon in PowerPoint 2007. 

If you are using Office 2008 (Mac), there is one icon:  

If you are using Office 2011 (Mac), there is both a toolbar similar to the one pictured above, as well as a 
menu. Microsoft does not allow 3rd-party applications like MathType to modify the Ribbon in Office 
2011, so we're unable to create a tab like we do on Windows. 
 
If your toolbar looks like the one above, notice there are four Greek letter Sigmas. Each of these will open 
MathType and allow you to insert an equation into your document. The difference between them is in the 
placement of the equation and its relationship to the surrounding text. 
 

 – “Insert Inline Equation” – Inserts an equation inline with your text. An inline equation becomes part 
of your paragraph, and moves with the text when you add or delete text. This is an example of an 
inline equation: 2 2 2a b c+ = . 

 
 – “Insert Display Equation” – Inserts an equation below the current line of text, like this one: 

 ( ) 1 2 1 2, ,
2 2

x x y yx y + +⎛ ⎞= ⎜ ⎟
⎝ ⎠

 

 When MathType inserts a display equation, it centers the equation on the line, and places the cursor 
on the line below the equation, so that when you close MathType, you’re ready to continue typing. 

 
 and  – “Insert Numbered Display Equation” – Acts exactly like the previous icon, except places an 

equation number either at the left or right margin, depending on which of the two icons you select. 
Here is a “Right-Numbered Display Equation”: 

 ( )3 2
2 3sin 2π= − +y x  (4.1) 

  When inserting equation numbers, you can format them however you want – with or without 
section or chapter numbers, with any kind of separator between the numbers (e.g., 1.1, 1-1, 1_1, 
etc.), and with or without any kind of brackets you choose. 

 
 – “Toggle between TeX/LaTeX and MathType equations” (not available on the Mac) – This is a huge 

shortcut if you know the TeX language. Even if you don’t know TeX, it’s pretty simple for many 
things. For example, if you type $\sqrt2$ and click this icon, you’ll get 2  in your document 
without opening MathType. Other shortcuts for the “Toggle TeX” button: 
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 \frac{numerator}{denominator} produces a fraction 
 \sqrt{radicand} gives a square root, and \sqrt{index}{radicand} gives an nth root 
 For Greek letters, type the backslash followed by the name of the letter. 
 \alpha = α , \omega =ω , \pi = π , etc.  
 Be sure to enclose the expression in $ signs, e.g., $\frac{\pi}{4}$ 
 
The next four icons on the MathType toolbar all have to do with equation numbers. Note that these are 
not problem numbers, as in a test or quiz. They are equation numbers like you may see in a textbook or in 
a journal article when the author needs to refer to a particular equation number in the text of the article. 
There are very few times when a primary or secondary school math teacher would need to number 
equations.  
 

 – “Insert Equation Number” – Inserts an equation number at the current position of the cursor. This 
icon is most often used to add an equation number to a display equation that’s already in your 
document. 

 – “Insert Equation Reference” – Inserts a reference in the text of the document, and links the 
reference to a particular equation number. For example, I may say something like this: “In equation 
(4.1) above, the number 2 indicates a vertical shift of 2 units up.” If I were to decide I needed a new 
numbered equation above the current equation (4.1), the new equation would become (4.1), and the 
current equation would be re-numbered (4.2). Since the reference I wrote above is linked to this 
equation number, it also changes to (4.2). 

 
 – “Insert Chapter/Section Break” – Chapter and section numbers are not required when you’re 

numbering your MathType equations, but if you do use them, you’ll need to change the chapter or 
section number when you move to the next chapter or section. 

 
 – “Update Equation Numbers” – This icon isn’t needed very often, because when you add an 

equation prior to an existing numbered equation, the equation numbers and references that follow 
the new equation are automatically updated, as I described above. When you remove an equation 
though, the numbers aren’t updated. (They may update when you save or print the document, 
depending on how you have your Word options set up.) Selecting this icon will update the equation 
numbers immediately. 

 
The last icon on the MathType toolbar doesn’t have anything to do with inserting equations or equation 
numbers; this icon affects the entire document. 
 

 – “Export to MathPage” – This will transform the entire Word document into a nice-looking web 
page. For more information on exactly what happens when you click this icon, refer to the tutorial 
Creating Webpages with Microsoft Word in the MathType 6 help file (Getting Started > More 
Tutorials > Creating Webpages with Microsoft Word). 

 
To the right of “Export to MathPage” is the “Browse by” window. You can choose to browse by 
equations, equation numbers, or chapter/section breaks. This is similar to the way you can click an icon in 
Word and go to the next page. 
 

 – Equation Browse – Clicking the right arrow will take you to either the 
next equation in the document, and the left arrow will take you to the previous equation.



 

    page 6 

4. Setting MathType Fonts & Sizes (the Style and Size menus) 
 
You most likely want your equations to match the text in your document, PowerPoint presentation, or 
web page, so you need to know how to change the fonts & font sizes in MathType. 
 
The Style Menu – setting the fonts. 

You’ll see several style names listed on the MathType Style menu, 
but the one you’ll use most often is called “Math”. Actually, Math 
isn’t a style of its own; it’s a combination of other styles. 
MathType is smart enough, for example, to know that when you’re 
typing ( )2sin xπ , you probably want the variable and the lower-case 
Greek letter to be italicized, but not the function name or the 
number. Thus, MathType switches between Function, Variable, 
Greek-Symbol, and Number styles as appropriate. (“Number” isn’t 
a style you see on the menu, but it is a separate style of its own, as 
we’ll see in a minute.) To set all this up, select “Define”, at the 
bottom of the menu. 
 

When you select Define, you’ll 
see another “dialog box”. (A 
“dialog box”, or simply “dialog”, 
is a window like the one shown to 
the right where you can select 
options and settings.) 
 
In the Define Styles dialog, you’ll 
see a couple of “radio buttons” 
labeled Simple and Advanced. 
We’ll go over each of these. 
“Simple” is the one you’ll use 
most often. 
 
In the selection labeled “Primary font”, the font you choose will be the font MathType will use for text, 
function names, variables, vector and matrix names, and numbers. Normally you’ll want all of these to 
be the same font, but we’ll see in a minute how to make them different. You’ll probably want the 
Primary font to be the same font you’re using in your document. MathType doesn’t know what font 
you’re using in your document, so it’s important to set it here. 
 
The selection labeled “Greek and math fonts” isn’t normally changed. You’ll see you have only two 
options there anyway – “Symbol and MT Extra” and “Euclid Symbol and Euclid Extra”. You likely 
won’t see much difference between these two choices, so leave it set as you see above. 
 
At the lower right of this dialog is a final checkbox, labeled “Use for new equations”. This is checked 
by default, and if you leave it checked, all subsequent equations you create will use these same font 
settings until you change them again. If you’re just wanting the next equation to have a certain special 
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look, but want the rest of the equations to look like the equations before the one you’re working on, 
uncheck this box. 
 
After everything’s set the way you want it, click OK and the dialog closes. 
 
Now click on Style/Define again, 
and this time select Advanced. 
You’ll see the dialog that’s 
pictured to the right. This is where 
you would make special settings, 
like if you wanted all the numbers 
in Arial and the rest of the 
equation in Times New Roman, 
for some reason. Notice also the 
boxes labeled Bold and Italic. 
Check or uncheck as desired. (By 
the way, “L.C. Greek” is lower-
case Greek. Guess what “U.C. 
Greek” is?) 
 
User 1 and User 2 styles are not 
normally used, but when you need 
them, they’re quite handy. One 
example where you may want to 
use a “User” style is if you’re 
discussing the effect of a 
variable’s coefficient on a graph (or you want the student to do so), so you choose to have the variables 
in Times New Roman italic, but the coefficient in Times New Roman bold italic. For example, I could 
say, “Describe the effect on the graph of the function when the value of a increases: 2y x bx c= + +a .” 
In this example, I used User 2 style for the coefficient a. 
 
The Size Menu – setting the sizes. 
Just like MathType automatically changes the style depending on the types of items contained in your 
equation, it also changes sizes. For most of your equations, you’ll just leave the size specification set to 
“Full”. When you type an exponent, MathType knows you want it to be smaller than the base, so it 

switches to “Subscript” size. Likewise, if you’re teaching sequences 
and series, and want to enter a summation template, MathType knows 
to create the Sigma symbol larger than the surrounding variables and 
numbers, so it switches to “Symbol” size. Even though this switching 
is automatic, you still have control over what sizes MathType uses 
when it selects these special sizes. To specify these sizes, select 
“Define” at the bottom of the Size menu. 
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The “Define Sizes” 
dialog is quite 
different from the 
Define Styles dialog. 
One of the major 
differences is the 
presence of a 
“preview window”. 
The preview window 
doesn’t show you 
the actual equation 
you may be working 
on, but it does give you an indication of what exactly will change if you change the setting that’s 
highlighted to the left of the preview window. For example, in the picture above, the only thing that 
will change in that sample equation when I change the “Full” size setting (notice the “12” is 
highlighted) is the X. 
 
In MathType, the size setting called “Full” is the setting that you want to be identical to the text size in 
your document. If you’re typing a test, and you’re using 11-pt type size, make sure the MathType 
“Full” size is set to 11-pt. 
 
Notice the rest of the sizes (except “Smaller/Larger Increment”) are specified as a percent. Percent of 
what? These are percentages of the “Full” size. The beauty of leaving these set as percentages is that 
once you set them, you never have to change them! If you change the Full size from 10-pt (like you 
may use in a quiz) to 32-pt (like you may use in PowerPoint or on an overhead transparency), you 
don’t have to change the other sizes because they’re still proportionally correct. If you want to set these 
other sizes as point sizes, you have that option, but chances are you won’t want to. (Notice there’s a 
User 1 and User 2 size. Use these similarly to the way you’d use a User 1 or User 2 style.) 
 
So, what’s a “Smaller/Larger Increment”? Notice back up on the MathType Size menu (pictured at the 
bottom of the previous page), two items near the bottom are labeled “Smaller” and “Larger”. If you 
want to make an item or items in your equation smaller or larger than the surrounding items in the 
equation, you can select them, and repeatedly select Smaller or Larger from the Size menu until you 
get the size you want. How much smaller or larger MathType makes them is determined by the 
“Smaller/Larger Increment” on the Define Sizes dialog.  
 
BEWARE – It’s generally not a good idea to highlight an entire equation and select Smaller or Larger, 
because the results will almost certainly not be what you wanted! (see below) If you want to increase 
or decrease the size of an entire equation, the best way to do it is by changing the Full size 
specification. You may want to deselect the “Use for new equations” checkbox. 
 

 Example: 10-pt: 2x ; 18-pt: 
2x ; 10-pt plus 8 “larger” applications: 2x  

 
Notice that the 18-pt expression is proportionally correct, but the 10-pt equation that was converted to 
18-pt by repetitively clicking “larger” on the size menu has an exponent that is too large. That’s 
because both the base and the exponent are increased by 1-pt each time you click on “larger”. 
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6. Creating a blank grid for student graphing 
One of the most common questions we get is “Does MathType make graphs?” I always give a 
“qualified” answer to that question – No, MathType won’t graph a function, but you can make a blank 
grid for students to do the graphing. Note: There is a more detailed procedure for grids and number 
lines on our web site. You can access this tip at 

http://www.dessci.com/grids 

(This will be done using Equation Editor. If you are using MathType, the steps are similar.) 

a. In a Microsoft Word (the procedure may be adapted for other software), open Equation 
Editor From the Insert menu, and select Object. From the list, choose “Microsoft 
Equation”, and click OK. 

b. On the Matrix templates palette, select Variable-size matrix or table. 
 
 
You can look at the “Status Bar” – the very bottom of the Word or MathType window – to see 
what it is you’re pointing to: 
 

c. In the Matrix dialog, specify the size you want. You probably want 
a larger one than 6×6, but we’ll use this size as an example. The 
maximum size is 30×30, so if your axes will be in the center, that’s 
±15 on both axes. Notice the comment at the bottom of the dialog: 
“Click between elements to add/change partition lines.” 

d. There are 4 types of lines: no line (the default), solid line, dashed 
line, and dotted line. You select the type of line by continuing to 
click in the same location (twice for dashed, etc.). If you put solid 

axes in the center of the 
grid, and dotted lines 
everywhere else, the screenshot to the left is what the 
dialog would look like when you’re through. Below is 
what the grid looks like in your finished test, quiz, or 
whatever (these are dotted lines except the axes). 

In MathType, the column and 
row specifications are in a 
different place, and there is a 
“Clear all lines” button, which is 
handy. You can also save the 
grid on the MathType toolbar, 
which you can’t do in Equation 
Editor. 
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8. Nudging and the MathType Customizable Toolbars 
Nudging is a technique that can be accomplished in both Equation Editor and MathType, and is 
very useful in achieving perfect positioning for your equations. 
 
1. For example, let’s say you’d like more space between an integral symbol and the limits of 

integration. We’ll add more space by nudging the limits to the right. 
 

2. Select the upper limit. The most common method to select items is to drag the mouse across the 
item. For small items though, such as limits, subscripts, etc., it’s easier to use the Shift and arrow 
keys. With the cursor to either the left or right of the item you want to select, hold down the Shift 
key as you press the either the left or right arrow key, as appropriate. Release the Shift key after 
you’ve completed the selection. 
 

3. Hold down the Ctrl key. Use the arrows on the keyboard to move the selected item(s) in the desired 
direction.  
 

( )∫
∞

0
dxxf  ( )∫

∞

0
dxxf  

before nudging after nudging 

 Note that not all printers will print the limits as tightly-spaced as the ones in the “before” example. 
You may have to experiment with nudging a bit in order to find the proper amount. 

If you’re using MathType, you can save the newly-nudged expression or equation to the toolbar. That 
way you don’t have to nudge it every time you use it:  

 
If you want a more generic situation than what’s shown above (you won’t always want limits of zero to 
infinity), see “Saving to the MathType toolbar” on page 17 of this handout for a hint about how to do 
that. 
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9. Aligning items within an equation 
There are all sorts of things to align within an equation – the subtraction shown beneath a dividend in a 
long division problem, equations in a system of equations, items in a pictogram, responses in a 
multiple-choice question, etc. We will look at two of these: systems and multiple-choice. Note: Even if 
you don’t teach the level of math requiring systems of equations, and even if you never create multiple-
choice tests, the techniques learned here will still be useful to you. 

9a. Systems of equations and inequalities 
a. There is no right or wrong way to “align” the equations in a system; it’s basically a matter of 

choice, and a matter of what your students can read the best. (For simplicity, we won’t specifically 
mention systems of inequalities, but these exact steps will work for those as well.) Here are 4 
different scenarios: 

3 4 17 3 3
5 3 6

2 3 2 15 2 3 2 3
2 7 2

4 3 2 3 3 2 3

x y z x x
x y

x y z x y x y
x y

x y x y z x y z

+ + = = =⎧ ⎧ ⎧
− =⎧ ⎪ ⎪ ⎪+ + = + = + =⎨ ⎨ ⎨ ⎨+ =⎩ ⎪ ⎪ ⎪+ = + + = + + =⎩ ⎩ ⎩+

1 2 3 4

 

b. Systems 2 and 3 above present the greatest challenge, so let’s deal with system 2. 

c. In this system, we want to align the variables, the operation symbols (+, −, or =), and the sums so 
that they are vertically aligned with similar elements in the previous equation, and right-justified 
within each column (for example, z & 2z and 15 & 4 in system 2 above). 

d. There are many ways to align a system, but let’s just cut to the chase and say that using a matrix is 
the best way to do it. So with that established, what size? The obvious number of rows is a number 
equal to the number of equations. There are several choices for the number of columns, but the best 
balance between utility and ease of use is a number of columns equal to the number of equations 
plus one. So our matrix for system 2 above will be a 3×4. 

e. The first step is to insert the Left brace from the Fences palette on the Equation Editor or 
MathType toolbar. The icon you’re looking for on the Fences palette is this one:        . (It’s in 
column 1, 4th from the bottom.) 

f. Next insert a 3×4 matrix by selecting “Variable-size matrix” from the Matrix templates palette, 
making sure to select Column align: Right in the Matrix dialog. 

g. Now you’re ready to insert the equations into the matrix, but how you do it is critical! Enter 3x + in 
the first cell, press Tab to go to the next cell, enter 4y +, press Tab, enter z =, press Tab, and enter 
17 in the last cell. Pressing Tab once more gets you down to the next 
row to begin entering the second equation. Enter the next 2 
equations similarly. This is how it should look when you’re done 

3 4 17
2 3 2 15

4

x y z
x y z
x y

+ + =⎧
⎪ + + =⎨
⎪ + =⎩ +

So, how do you get the right amount of space where the “+” should be? In Equation Editor, 
your only choice is to add spaces. Problem is, 3 isn’t enough and 4 is too many. In MathType, 
there’s a more elegant (and more exact) way: insert a +, then color it  white  ! 
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9b. Multiple-choice responses 
a. There are many ways to type multiple choice responses for a test or quiz. You may create each 

choice as a separate equation (remember, we use the word “equation” to denote anything created 
with Equation Editor or MathType, regardless of whether or not it contains an equals symbol), or 
you could include all the responses in a single equation and arrange them in various ways. Two 
common ways to arrange the responses are to place them all on the same line of text or to put two 
responses on one line and two on another line. We’ll deal with the first option here. 

b. For this example, we’ll create the responses for this question: 
 
 1. Find the quotient: ÷2 1

3 21 1  
 
  3 1 1

5 2 9a.  2 b.  2 c.  1 d.  2  

c. One option would be to type the question and all the responses as a single equation, but we’ll type 
the question text in Word and the division expression and responses in Equation Editor or 
MathType. We’ll type all 4 responses as one object. 

d. Assuming you’ve already typed the question, let’s work on the responses. Open Equation Editor as 
you normally would, either from the Insert menu or by clicking the icon on your Word toolbar. 
(This will be specifically Equation Editor. These steps will work, of course, in MathType as well, 
but there will be separate steps for MathType later.) 

e. We’re using Arial font and 11pt size, so adjust your Style and Size accordingly. If you don’t 
remember how to do that, see page 3 of this handout. 

f. We want to space the responses uniformly, and the best way to do that is to use a matrix. This will 
be a 1-row, 4-column matrix, so go ahead and insert one of those in your document. 

g. Change to Text style, then type the letter a followed by a period and a space. 
(Notice the space bar works just fine in Text style.) Change to Math style, then 
type 3

52 . When you type the fraction, be sure to use the Reduced-size vertical 
fraction, which is the one in the upper-right of the Fraction and radical 
templates palette. 

h. An easy way to keep from switching from Text to Math four times is to copy what you just typed 
(i.e., select the contents of the first cell with your mouse, then press Ctrl+C or Cmd+C to copy). 
Now press Tab to go to the next cell, and paste the contents into that cell (Ctrl+V or Cmd+C is the 
shortcut). Do the same with the remaining 2 cells, then edit the contents so that it looks similar to 
the above example. We’ll adjust the spacing in the next step. 

i. Since this is a matrix, and you already know how to adjust the column spacing in a matrix, go 
ahead and adjust it to see what looks best. (I think somewhere in the range of 300-400% looks best, 
but that’s just my opinion. Use whatever setting you like.) 
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j. In MathType, you have another tool that makes it even easier to create multiple-choice responses, 
and easier to keep the spacing uniform from one question to the other. If you’re using MathType, 
click on the View menu and make sure there’s a checkmark by Ruler.  

k. Notice above the ruler there are 5 arrows. These arrows represent 5 types of tabs that are available 
in MathType. From left to right, these are: 

1) Left-justified tab. This is the one selected in the screenshot below, and is the default. When you 
use a left-justified tab, the left edge of the text will be aligned at the tab. 

2) Center-justified tab. The center of the text is aligned at the tab stop. 

3) Right-justified tab. The right edge of the text is aligned at the tab stop. 

4) Relational tab. Use this tab only with more than one line of characters within your equation. 
This will align equations or inequalities at any relational operator, such as ≠, ≥, ≡ , ∝ , and of 
course =. (Basically, it will align on the equals, greater than, or less than signs from the 
keyboard, plus anything on the Relational symbols palette.) 

5) Decimal tab. Use this one also for more than one line of characters. This is for aligning a 
column of numbers, regardless of whether or not a decimal point is present. 

 

l. To set a tab stop, simply select the type of tab you want to use and click on the ruler below the 
number or tick-mark where you want the tab to be. Caution: Each template slot has its own set of 
tabs, so if you are inside a numerator slot (for example), and set a tab at the 1” mark, that tab will 
not be set outside the fraction! In the example above, make sure your “insertion point” (i.e., cursor) 
is outside the fraction before you set the tab. You won’t run into this problem if you set your tabs 
prior to typing the MathType equation, but you won’t always know where you want the tabs set 
before you start typing. Just be aware of this feature of tabs. 

m. For our example, since we’re using tabs to align the multiple-choice responses, we don’t need our 
1×4 matrix. You can use the matrix if you want, of course, but you wouldn’t use both a matrix and 
tabs. 

n. One final point on tabs. You already know what the Tab key’s for when you’re typing in 
MathType; it’s to move from one template slot to another, or to move out of the template. To move 
to the next tab stop, you need to press the Ctrl+Tab keystroke combination. 
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10. Using Word’s AutoCorrect Feature 
Some things you create with Equation Editor or MathType are repetitive – the grid discussed earlier, 
for example. If you’re creating a worksheet on graphing linear functions, you’ll quite likely have 10 or 
20 of these, so it’s very useful to be able to insert a grid with just a few keystrokes – and without even 
opening up MathType! 

Note: There is a more detailed tip on our web site for using Word’s AutoCorrect and AutoText 
features. You can access this tip at 

www.dessci.com/autocorrect 

(This will be done using Equation Editor. If you are using MathType, the steps are similar. Since many 
of the things we’ve done in this session has been done with Equation Editor, you may wonder what’s 
so much better about MathType? There’s a page later in the handout that discusses this.) 

Setting up AutoCorrect to Insert Equation Objects 

a. For the purpose of this mini-tutorial, we’ll 
use the grid created earlier. Insert the 6-by-6 
grid into your document: 

 

b. If it doesn’t appear to be perfectly square, 
you can make it square by clicking on it with 
your right mouse button (Mac, Ctrl+click), 
then selecting Format Object from the 
menu. If Format Object doesn’t appear on 
the right-click menu, select Object from 
Word’s Format menu. (In Word 2007, if 
Format Object isn’t be in the right-click 
menu, click on the Drawing Tools > Format 
tab in the Ribbon, then adjust the size in the 
Size group.)  
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i. Now that you’re back in your document, delete the grid and try your AutoCorrect entry. Type gr6a 
(or whatever code you entered), followed by the spacebar. Your code should be replaced with a 
grid. 

Here are some notes about what we just did: 

1. I had you hit the spacebar after the code, but there’s nothing magical about the spacebar. The 
important thing is that you tell Word that you’re through typing that word, and in this case, our 
word was gr6a. Think about what normally “terminates” a word – a space character, any 
punctuation character, a Tab, a new line, or even a mathematical operator (such as < or =). In fact, 
any of these things will replace your code with your grid (or whatever you entered into the 
AutoCorrect box). 

2. The code I chose – gr6a – may seem a little cryptic to you, and you may not think you can 
remember that one. That’s fine; choose whatever code you’ll remember, but be careful! You don’t 
want to choose a word that will likely appear in any document. The words “grid” or “graph”, for 
example, appear often, so you don’t want to choose these. I’m 100% sure the code I chose will 
never come up in any document ever – unless I want a 6-by-6 grid. 

3. What other uses for AutoCorrect can you think of?  I can think of several: 
 

sq2 for 2  

qu or qform for 
2 4

2
b b ac

a
− ± −  2p/3 for 2

3
π  

1/8 for 1
8 , etc. 

imat3 or simply i3 for 
1 0 0
0 1 0
0 0 1

⎡ ⎤
⎢ ⎥
⎢ ⎥
⎢ ⎥⎣ ⎦

 
limx0 for 

0
lim
x→

 

u238 for 238
92 U gr-th for θ , etc. 

xb or xbar for x   

 …and so on. 

4. You can use AutoCorrect for even more complex objects than the ones we’ve used, but that’s 
really a subject to deal with elsewhere – like in the Tip I mentioned earlier that’s available on our 
web site! 
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13. Making Changes to a Matrix 
Sometimes you may wish to modify an existing matrix. This may happen for any one of several 
reasons – you need to change the matrix dimensions, you need to change the column alignment, you 
need to add or remove partition lines, etc. We’ll first look at changing a matrix in Equation Editor, then 
see the additional matrix features in MathType. 

Example 1. You have this problem on a test: 

 4. Add the matrices: ?
43
21

13
57

=⎥
⎦

⎤
⎢
⎣

⎡
+⎥

⎦

⎤
⎢
⎣

⎡  

You’d like to make problem #5 a matrix multiplication problem, a 3x2 matrix multiplied by a 2x3 
matrix. You decide to use the matrices from problem #4, and adjust the dimensions. Here’s what you 
need to do: 

1. Copy the matrices from problem #4 and paste them into problem #5: 
 

 5. Multiply the matrices: ?
43
21

13
57

=⎥
⎦

⎤
⎢
⎣

⎡
+⎥

⎦

⎤
⎢
⎣

⎡  

 

2. Now let’s change from addition to multiplication, and add a new row 3 to matrix 1 and a new 
column 3 to matrix 2. 

a. Double-click the matrices to open the problem in Equation Editor: 
 
 
 
 
 
 
 

b. Click inside matrix 1 so that the insertion point is flashing inside one of the matrix cells: 
 
 

 

 

 

c. In the Format menu, click on Matrix:  
 

  
Correct Incorrect! 
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d. Change the matrix dimensions to 2 columns and 3 rows. Similarly, change the dimensions of 
matrix 2 to 3 columns and 2 rows. Insert the contents of the empty cells. Question 5 now looks 
like this: 
 

5. Multiply the matrices: ?
643
521

42
13
57

=⎥
⎦

⎤
⎢
⎣

⎡

⎥
⎥
⎥

⎦

⎤

⎢
⎢
⎢

⎣

⎡
 

 
3. Re-dimensioning a matrix in this way will always result in new columns being added to the right 

and new rows added to the bottom. Making a matrix smaller will remove columns and rows from 
the right and bottom, respectively. This is the only way to re-dimension a matrix in Equation 
Editor. MathType gives you more utility by allowing you to add or remove a row or a column 
anywhere in the matrix: 
 

  
Example 2. You need to add a partition line to a 3x4 matrix to make it an augmented matrix: 
 

2 2 9
3 4

2 5 10

x y z
x y
x y z

− + =⎧
⎪− + = −⎨
⎪ − + =⎩

+ ⇒
1 2 2 9
1 3 0 4
2 5 1 10

−⎡ ⎤
⎢ ⎥− −⎢ ⎥
⎢ ⎥−⎣ ⎦

 

 
1. With your cursor inside one of the cells in the matrix, click on Format > Matrix. (If using 

MathType, click on Format > Matrix > Change Matrix.) 

2. Click once between rows 3 & 4 for a solid line, twice for a dashed line, or 
three times for a dotted line:  (Hint: use decimal alignment in the matrix.) 

 
1 2 2 9
1 3 0 4
2 5 1 10

−⎡ ⎤
⎢ ⎥− −⎢ ⎥
⎢ ⎥−⎣ ⎦
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If you have MathType, see if you can duplicate the equations below. If you don’t have MathType, this would be a 
good opportunity to download the evaluation version from the Design Science web site. 

 

Other uses of MathType that go “beyond the basics”… 
1. Systems of equations. 

 
3 4 17 3 3

5 3 6
2 3 2 15 2 3 2 3

2 7 2
4 3 2 3 3 2 3

x y z x x
x y

x y z x y x y
x y

x y x y z x y z

+ + = = =⎧ ⎧ ⎧
− =⎧ ⎪ ⎪ ⎪+ + = + = + =⎨ ⎨ ⎨ ⎨+ =⎩ ⎪ ⎪ ⎪+ = + + = + + =⎩ ⎩ ⎩+

 

 
2. Dimensional analysis. 

 
30 miV =

h
5280 ft
1 mi

⋅
1 h

⋅
60 min

1 min
⋅
60 sec

44ft sec=

   or   
30 miV =

h
5280 ft
1 mi

⋅
1 h

⋅
60 min

1 min
⋅
60 sec

44ft sec=

 

 
3. Step-by-step examples with comments. 

 
( )
( )

00

0.21

.021

0.21

160; 68 ; 212 ; and 0.21

160 68 212 68
92 144

92
212

ln 92 ln144 0.21
ln 92 ln144

0.2

f r

rt
f r r

t

t

t

T T rTT T T T e

e
e

e

t

−

−

−

−

= = ° = ° == + −

= + −
=

=

− = −
−

−

Isolate the exponential expression.

Take the natural logarithm of both sides.

1
2.13345106

t

t

=

=

Calculation - ready form

 

 
4. Equations for Web pages. 

 
5. Animated graphics for PowerPoint presentations or Web pages. 

 
6. Chemistry notation. 

 
3 2 4 3 3 2 4 3

Solution Solution Pr ecipitate Solution

Ba(NO ) (aq) 2 NH IO (aq) Ba(IO ) (s) 2 NH NO (aq)+ → +���	��
 ���	��
 ��	�
 ���	��
  

Atomic Bonding
orbitals orbital

2p 2p2s 1s 2s

F H F H

↑↓ ↑↓ ↑↓ ↑ + ↓ ⎯⎯→ ↑↓ ↑↓ ↑↓ ↑↓
ii ii

ii ii
i i

������

���	��

: : 

 

This is a good use 
of User 1 and 
User 2 styles and 
sizes (MathType 
only). This lets 
you use your 
normal font & 
size for the 
problem & 
solution, and a 
separate font & 
size for the 
notes. 



 

    page 26 

What else can I do with MathType that I can’t do with Equation 
Editor? 

 
1. MathType includes over 200 symbols and templates that are not included in Equation Editor. Some 

of these are shown here. (Many of these are currently available only in the Windows version.) 
a bExamples: †≈� � ∼ : 1 U R \ ( ) & ≯ �  

In addition, MathType includes the ability to include a tilde, hat, arc, or harpoon (vector barb) over 
more than one character. It also includes cross-out templates for showing cancellation. 

qExamples: inchesABC  
 

2. Color. MathType lets you color all or part of an equation, or use multiple colors in a single 
equation. This is great for making captivating PowerPoint presentations or for printing color 
transparencies on an ink jet printer. Example: 

1 5 2 1 5 2 5 7Find the LCD: 
2 2 2 2x x x x x

+ = ⋅ + = + =
2 2x x

 

 
 

3. Web publishing. MathType lets you save your equations as GIFs to use in your web documents. 
MathType can also generate MathML – an XML application that is the W3C standard for 
publishing mathematics on the web, and makes math “accessible” to those with sight impairments 
or learning disabilities. 
 

4. Equation numbering. Not everyone needs to number equations or include references to equations in 
the text of a document. If you are a textbook author or write manuscripts for journal publication, 
you will appreciate the fact that MathType can number and reference your equations automatically 
when used with Microsoft Word. 
 

5. Precise formatting ruler. You get a sophisticated word processor-like ruler for 
precise formatting. Align columns at operators, decimal points, or set tab stops to 
make formatting easier and to give your documents a more professional look. This 
example cannot be duplicated exactly in Equation Editor for two reasons: cross-out 
templates, and ruler formatting (fractions aligned at right edge with a right-
justified tab).  

  
6. New spacing adjustments possible:  

• Radical “check mark” width adjustment:  2  2  2  
• Subscript and superscript horizontal gap:  

2x  
2x  

2x  
• Slash and diagonal fraction gap:  1

2  1
2  1

2  
• Horizontal gap between fence templates (parentheses, brackets, braces, etc.) and their contents:  

( )2 4x −  ( )2 4x −  ( )2 4x −  

• Stroke thickness for box lines, strike-throughs, radical signs, etc:  
1

2

2

2
⋅

2

 1

2

2

2
⋅

2

 1

2

2

2
⋅

2

 

1 2
2 23 3⋅ =

2
2
6

4
3 3
4 4

3
42

− −

Denominators in red. 


